Software Manual

R&S SMx RF and Baseband Correction Toolkit

R&S® SMU-K63
1161.0866.02

R&S® SMATE-K63
1404.7400.02
The following abbreviations are used throughout this manual:
The Vector Signal Generators R&S® SMU200A, R&S® SMJ100A and R&S® SMATE200A are abbreviated as R&S SMx, the Baseband Signal Generator and Fading Simulator R&S® AMU200A is abbreviated as R&S AMU, and the I/Q Modulation Generators R&S® AFQ100A and R&S® AFQ 100B are abbreviated as R&S AFQ.
The Spectrum Analyzers R&S® FSL, R&S® FSU, R&S® FSP and the Signal Analyzer R&S® FSQ are abbreviated as R&S FSx.

This firmware makes use of valuable open source software packages. The most important of them are listed below together with their corresponding open source license. The verbatim license texts are provided in the following chapters.

<table>
<thead>
<tr>
<th>Package</th>
<th>Link</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>oncrpc.jar, portmap.jar</td>
<td><a href="http://fsf.org/">http://fsf.org/</a></td>
<td>GPL 3/LGPL 3</td>
</tr>
<tr>
<td>balloontip.jar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ExampleFileFilter.java</td>
<td><a href="http://docs.sun.com/app/docs/doc/806-1067/6jacl3e82?a=view">http://docs.sun.com/app/docs/doc/806-1067/6jacl3e82?a=view</a></td>
<td>-</td>
</tr>
<tr>
<td>JGoodiesLooks</td>
<td><a href="https://looks.dev.java.net/">https://looks.dev.java.net/</a></td>
<td>BSD</td>
</tr>
<tr>
<td>JGoodiesForms</td>
<td><a href="https://forms.dev.java.net/">https://forms.dev.java.net/</a></td>
<td>BSD</td>
</tr>
</tbody>
</table>

Rohde & Schwarz would like to thank the open source community for their valuable contribution to embedded computing.

R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.
Trade names are trademarks of the owners.
Grouped Safety Messages

Make sure to read through and observe the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety standard of our products up to date and to offer our customers the highest possible degree of safety. Our products and the auxiliary equipment required for them are designed and tested in accordance with the relevant safety standards. Compliance with these standards is continuously monitored by our quality assurance system. The product described here has been designed and tested in accordance with the EC Certificate of Conformity and has left the manufacturer's plant in a condition fully complying with safety standards. To maintain this condition and to ensure safe operation, observe all instructions and warnings provided in this manual. If you have any questions regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must not be used in any way that may cause personal injury or property damage. You are responsible if the product is used for an intention other than its designated purpose or in disregard of the manufacturer's instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation and within its performance limits (see data sheet, documentation, the following safety instructions). Using the product requires technical skills and a basic knowledge of English. It is therefore essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions and the product documentation in a safe place and pass them on to the subsequent users.

Symbols and safety labels

<table>
<thead>
<tr>
<th>!</th>
<th>18 kg</th>
<th>⚠️</th>
<th>⚠️</th>
<th>⚠️</th>
<th>⚠️</th>
</tr>
</thead>
<tbody>
<tr>
<td>Observe product documentation</td>
<td>Weight indication for units &gt;18 kg</td>
<td>Danger of electric shock</td>
<td>Warning! Hot surface</td>
<td>PE terminal</td>
<td>Ground</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ground terminal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attention! Electrostatic sensitive devices</td>
</tr>
</tbody>
</table>

| | | | | | |
|---|---|---|---|---|
| Supply voltage ON/OFF | Standby indication | Direct current (DC) | Alternating current (AC) | Direct/alternating current (DC/AC) |
| Device fully protected by double/reinforced insulation |

Observing the safety instructions will help prevent personal injury or damage of any kind caused by dangerous situations. Therefore, carefully read through and adhere to the following safety instructions before putting the product into operation. It is also absolutely essential to observe the additional safety instructions on personal safety that appear in relevant parts of the product documentation. In these safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde & Schwarz group of companies, including instruments, systems and all accessories.
Grouped Safety Messages

Tags and their meaning

**DANGER**
DANGER indicates a hazardous situation which, if not avoided, will result in death or serious injury.

**WARNING**
WARNING indicates a hazardous situation which, if not avoided, could result in death or serious injury.

**CAUTION**
CAUTION indicates a hazardous situation which, if not avoided, may result in minor or moderate injury.

**NOTICE**
NOTICE indicates a property damage message.

In the product documentation, the word ATTENTION is used synonymously.

These tags are in accordance with the standard definition for civil applications in the European Economic Area. Definitions that deviate from the standard definition may also exist in other economic areas or military applications. It is therefore essential to make sure that the tags described here are always used only in connection with the related product documentation and the related product. The use of tags in connection with unrelated products or documentation can result in misinterpretation and thus contribute to personal injury or material damage.

Basic safety instructions

1. The product may be operated only under the operating conditions and in the positions specified by the manufacturer. Its ventilation must not be obstructed during operation. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
   - Prescribed operating position is always with the housing floor facing down.
   - IP protection category 2X, pollution severity 2.
   - Overvoltage category 2.
   - Operation altitude 2000 m above sea level.
   - Transport altitude 4500 m above sea level.
   - A tolerance of ±10% shall apply to the nominal voltage and of ±5% to the nominal frequency.

2. Applicable local or national safety regulations and rules for the prevention of accidents must be observed in all work performed. The product may be opened only by authorized, specially trained personnel.
   - Prior to performing any work on the product or opening the product, the product must be disconnected from the supply network. Any adjustments, replacements of parts, maintenance or repair must be carried out only by technical personnel authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant to safety (e.g., power switches, power transformers, fuses). A safety test must always be performed after parts relevant to safety have been replaced (visual inspection, PE conductor test, insulation resistance measurement, leakage current measurement, functional test).

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction (allergens, e.g., nickel) such as aluminum cannot be generally excluded. If you develop an allergic reaction (such as a skin rash, frequent sneezing, red eyes or respiratory difficulties), consult a physician immediately to determine the cause.

4. If products/components are mechanically and/or thermically processed in a manner that goes beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel) may be released. For this reason, the product may only be disassembled, e.g., for disposal purposes, by specially trained personnel. Improper disassembly may be hazardous to your health. National waste disposal regulations must be observed.
5. If handling the product yields hazardous substances or fuels that must be disposed of in a special way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the manufacturer of the hazardous substances or fuels and the applicable regional waste disposal regulations must be observed. Also observe the relevant safety instructions in the product documentation.

6. Depending on the function, certain products such as RF radio equipment can produce an elevated level of electromagnetic radiation. Considering that unborn life requires increased protection, pregnant women should be protected by appropriate measures. Persons with pacemakers may also be endangered by electromagnetic radiation. The employer/operator is required to assess workplaces where there is a special risk of exposure to radiation and, if necessary, take measures to avert the danger.

7. Operating the products requires special training and intense concentration. Make certain that persons who use the products are physically, mentally and emotionally fit enough to handle operating the products; otherwise injuries or material damage may occur. It is the responsibility of the employer to select suitable personnel for operating the products.

8. Prior to switching on the product, it must be ensured that the nominal voltage setting on the product matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power fuse of the product may have to be changed accordingly.

9. In the case of products of safety class I with movable power cord and connector, operation is permitted only on sockets with earthing contact and protective earth connection.

10. Intentionally breaking the protective earth connection either in the feed line or in the product itself is not permitted. Doing so can result in the danger of an electric shock from the product. If extension cords or connector strips are implemented, they must be checked on a regular basis to ensure that they are safe to use.

11. If the product has no power switch for disconnection from the AC supply, the plug of the connecting cable is regarded as the disconnecting device. In such cases, it must be ensured that the power plug is easily reachable and accessible at all times (corresponding to the length of connecting cable, approx. 2 m). Functional or electronic switches are not suitable for providing disconnection from the AC supply. If products without power switches are integrated in racks or systems, a disconnecting device must be provided at the system level.

12. Never use the product if the power cable is damaged. Check the power cable on a regular basis to ensure that it is in proper operating condition. By taking appropriate safety measures and carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be hurt by e.g. tripping over the cable or suffering an electric shock.

13. The product may be operated only from TN/TT supply networks fused with max. 16 A (higher fuse only after consulting with the Rohde & Schwarz group of companies).

14. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the socket. Otherwise, this can result in sparks, fire and/or injuries.

15. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric shocks.

16. For measurements in circuits with voltages $V_{\text{rms}} > 30$ V, suitable measures (e.g. appropriate measuring equipment, fusing, current limiting, electrical separation, insulation) should be taken to avoid any hazards.

17. Ensure that the connections with information technology equipment comply with IEC 950/EN 60950.

18. Unless expressly permitted, never remove the cover or any part of the housing while the product is in operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the product.

19. If a product is to be permanently installed, the connection between the PE terminal on site and the product's PE conductor must be made first before any other connection is made. The product may be installed and connected only by a license electrician.
20. For permanently installed equipment without built-in fuses, circuit breakers or similar protective devices, the supply circuit must be fused in such a way that suitable protection is provided for users and products.

21. Do not insert any objects into the openings in the housing that are not designed for this purpose. Never pour any liquids onto or into the housing. This can cause short circuits inside the product and/or electric shocks, fire or injuries.

22. Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a thunderstorm) can reach the product. Otherwise the operating personnel will be endangered by electric shocks.

23. Rohde & Schwarz products are not protected against penetration of liquids, unless otherwise specified (see also safety instruction 1.). If this is not taken into account, there exists the danger of electric shock for the user or damage to the product, which can also lead to personal injury.

24. Never use the product under conditions in which condensation has formed or can form in or on the product, e.g. if the product was moved from a cold to a warm environment.

25. Do not close any slots or openings on the product, since they are necessary for ventilation and prevent the product from overheating. Do not place the product on soft surfaces such as sofas or rugs or inside a closed housing, unless this is well ventilated.

26. Do not place the product on heat-generating devices such as radiators or fan heaters. The temperature of the environment must not exceed the maximum temperature specified in the data sheet.

27. Batteries and storage batteries must not be exposed to high temperatures or fire. Keep batteries and storage batteries away from children. Do not short-circuit batteries and storage batteries. If batteries or storage batteries are improperly replaced, this can cause an explosion (warning: lithium cells). Replace the battery or storage battery only with the matching Rohde & Schwarz type (see spare parts list). Batteries and storage batteries must be recycled and kept separate from residual waste. Batteries and storage batteries that contain lead, mercury or cadmium are hazardous waste. Observe the national regulations regarding waste disposal and recycling.

28. Please be aware that in the event of a fire, toxic substances (gases, liquids etc.) that may be hazardous to your health may escape from the product.

29. The product can be very heavy. Be careful when moving it to avoid back or other physical injuries.

30. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability are unsuitable for this purpose. Always follow the manufacturer's installation instructions when installing the product and fastening it to objects or structures (e.g. walls and shelves).

31. Handles on the products are designed exclusively for personnel to hold or carry the product. It is therefore not permissible to use handles for fastening the product to or on means of transport such as cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the means of transport and for observing the safety regulations of the manufacturer of the means of transport. Noncompliance can result in personal injury or material damage.

32. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely. Adequately secure the product in the vehicle to prevent injuries or other damage in the event of an accident. Never use the product in a moving vehicle if doing so could distract the driver of the vehicle. The driver is always responsible for the safety of the vehicle. The manufacturer assumes no responsibility for accidents or collisions.

33. If a laser product (e.g. a CD/DVD drive) is integrated in a Rohde & Schwarz product, do not use any other settings or functions than those described in the product documentation. Otherwise this may be hazardous to your health, since the laser beam can cause irreversible damage to your eyes. Never try to take such products apart, and never look into the laser beam.

34. Prior to cleaning, disconnect the product from the AC supply. Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such as alcohol, acetone or diluent for cellulose lacquers.
Informaciones elementales de seguridad

¡Es imprescindible leer y observar las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al día con los estándares de seguridad y de ofrecer a nuestros clientes el máximo grado de seguridad. Nuestros productos y todos los equipos adicionales son siempre fabricados y examinados según las normas de seguridad vigentes. Nuestra sección de gestión de la seguridad de calidad controla constantemente que sean cumplidas estas normas. El presente producto ha sido fabricado y examinado según el comprobante de conformidad adjunto según las normas de la CE y ha salido de nuestra planta en estado impecable según los estándares técnicos de seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario deberá atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de empresas Rohde & Schwarz está siempre a su disposición en caso de que tengan preguntas referentes a estas informaciones de seguridad.

Además queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto está destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente autorizado, para aplicaciones de campo y de ninguna manera deberá ser utilizado de modo que alguna persona/cosa pueda sufrir daño. El uso del producto fuera de sus fines definidos o despreciando las informaciones de seguridad del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna forma responsable de consecuencias a causa del mal uso del producto.

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado dentro de las instrucciones de la correspondiente documentación de producto y dentro del margen de rendimiento definido (ver hoja de datos, documentación, informaciones de seguridad que siguen). El uso del producto hace necesarios conocimientos profundos y conocimientos básicos del idioma inglés. Por eso se debe tener en cuenta que el producto sólo pueda ser operado por personal especializado o personas minuciosamente instruidas con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el uso de productos de R&S, encontrará la información debida en la documentación del producto en el capítulo correspondiente. Guarde bien las informaciones de seguridad elementales, así como la documentación del producto y entréguela a usuarios posteriores.

Símbolos y definiciones de seguridad

<table>
<thead>
<tr>
<th>Verificación de producto</th>
<th>Informaciones para maquinaria con un peso de &gt; 18kg</th>
<th>Peligro de golpe de corriente</th>
<th>¡Advertencia! Superficie caliente</th>
<th>Conexión a conductor protector</th>
<th>Conexión a tierra</th>
<th>Conexión a masa conductor</th>
<th>¡Cuidado! Elementos de construcción con peligro de carga electroestática</th>
</tr>
</thead>
<tbody>
<tr>
<td>Potencia EN MARCHA/PARADA</td>
<td>Indicación Stand-by</td>
<td>Corriente continua DC</td>
<td>Corriente alterna AC</td>
<td>Corriente continua/alterna DC/AC</td>
<td>El aparato está protegido en su totalidad por un aislamiento de doble refuerzo</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Tener en cuenta las informaciones de seguridad sirve para tratar de evitar daños y peligros de toda clase. Es necesario de que se lean las siguientes informaciones de seguridad concienzudamente y se tengan en cuenta debidamente antes de la puesta en funcionamiento del producto. También deberán ser tenidas en cuenta las informaciones para la protección de personas que encontrarán en el capítulo correspondiente de la documentación de producto y que también son obligatorias de seguir. En las informaciones de seguridad actuales hemos juntado todos los objetos vendidos por el grupo de empresas Rohde & Schwarz bajo la denominación de „producto“, entre ellos también aparatos, instalaciones así como toda clase de accesorios.

Palabras de señal y su significado

<table>
<thead>
<tr>
<th>Palabra</th>
<th>Significado</th>
</tr>
</thead>
<tbody>
<tr>
<td>PELIGRO</td>
<td>Identifica un peligro directo con riesgo elevado de provocar muerte o lesiones de gravedad si no se toman las medidas oportunas.</td>
</tr>
<tr>
<td>ADVERTENCIA</td>
<td>Identifica un posible peligro con riesgo medio de provocar muerte o lesiones (de gravedad) si no se toman las medidas oportunas.</td>
</tr>
<tr>
<td>ATENCIÓN</td>
<td>Identifica un peligro con riesgo reducido de provocar lesiones de gravedad media o leve si no se toman las medidas oportunas.</td>
</tr>
<tr>
<td>AVISO</td>
<td>Indica la posibilidad de utilizar mal el producto y a consecuencia dañarlo.</td>
</tr>
</tbody>
</table>

En la documentación del producto se emplea de forma sinónima el término CUIDADO.

Las palabras de señal corresponden a la definición habitual para aplicaciones civiles en el área económica europea. Pueden existir definiciones diferentes a esta definición en otras áreas económicas o en aplicaciones militares. Por eso se deberá tener en cuenta que las palabras de señal aquí descritas sean utilizadas siempre solamente en combinación con la correspondiente documentación de producto y solamente en combinación con el producto correspondiente. La utilización de las palabras de señal en combinación con productos o documentaciones que no les correspondan puede llevar a malinterpretaciones y tener por consecuencia daños en personas u objetos.

Informaciones de seguridad elementales

1. El producto solamente debe ser utilizado según lo indicado por el fabricante referente a la situación y posición de funcionamiento sin que se obstruya la ventilación. Si no se convino de otra manera, es para los productos R&S válido lo que sigue:
   - como posición de funcionamiento se define por principio la posición con el suelo de la caja para abajo, modo de protección IP 2X, grado de suciedad 2, categoría de sobrecarga eléctrica 2, utilizar solamente en estancias interiores, utilización hasta 2000 m sobre el nivel del mar, transporte hasta 4.500 m sobre el nivel del mar.
   - Se aplicará una tolerancia de ±10% sobre el voltaje nominal y de ±5% sobre la frecuencia nominal.

2. En todos los trabajos deberán ser tenidas en cuenta las normas locales de seguridad de trabajo y de prevención de accidentes. El producto solamente debe de ser abierto por personal especializado autorizado. Antes de efectuar trabajos en el producto o abrirlo deberá estar el producto desconectado de la corriente. El ajuste, el cambio de partes, la manutención y la reparación deberán ser solamente efectuadas por electricistas autorizados por R&S. Si se reponen partes con importancia para los aspectos de seguridad (por ejemplo el enchufe, los transformadores o los fusibles), solamente podrán ser sustituidos por partes originales. Después de cada cambio de partes para la seguridad deberá ser efectuado un control de seguridad (control a primera vista, control de conductor protector, medición de resistencia de aislamiento, medición de la corriente conductora, control de funcionamiento).
3. Como en todo producto de fabricación industrial no puede ser excluido en general de que se produzcan al usuario elementos que puedan generar alergias, los llamados elementos alergénicos (por ejemplo el níquel). Si se producieran en el trato con productos R&S reacciones alérgicas, como por ejemplo urticaria, estornudos frecuentes, irritación de la conjuntiva o dificultades al respirar, se deberá consultar inmediatamente a un médico para averiguar los motivos de estas reacciones.

4. Si productos / elementos de construcción son tratados fuera del funcionamiento definido de forma mecánica o térmica, pueden generarse elementos peligrosos (polvos de sustancia de metales pesados como por ejemplo plomo, berilio, níquel). La partición elemental del producto, como por ejemplo sucede en el tratamiento de materias residuales, debe de ser efectuada solamente por personal especializado para estos tratamientos. La partición elemental efectuada inadecuadamente puede generar daños para la salud. Se deben tener en cuenta las directivas nacionales referentes al tratamiento de materias residuales.

5. En el caso de que se produjeran agentes de peligro o combustibles en la aplicación del producto que debieran de ser transferidos a un tratamiento de materias residuales, como por ejemplo agentes refrigerantes que deben ser repuestos en periodos definidos, o aceites para motores, deberán ser tenidas en cuenta las prescripciones de seguridad del fabricante de estos agentes de peligro o combustibles y las regulaciones regionales para el tratamiento de materias residuales. Cuiden también de tener en cuenta en caso dado las prescripciones de seguridad especiales en la descripción del producto.

6. Ciertos productos, como por ejemplo las instalaciones de radiocomunicación RF, pueden a causa de su función natural, emitir una radiación electromagnética aumentada. En vista a la protección de la vida en desarrollo deberían ser protegidas personas embarazadas debidamente. También las personas con un bypass pueden correr peligro a causa de la radiación electromagnética.

El empresario/usuario está comprometido a valorar y señalar áreas de trabajo en las que se corra un riesgo aumentado de exposición a radiaciones para evitar riesgos.

7. La utilización de los productos requiere instrucciones especiales y una alta concentración en el manejo. Debe de ponerse por seguro de que las personas que manejen los productos estén a la altura de los requerimientos necesarios referente a sus aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se pueden excluir lesiones o daños de objetos. El empresario lleva la responsabilidad de seleccionar el personal usuario apto para el manejo de los productos.

8. Antes de la puesta en marcha del producto se deberá tener por seguro de que la tensión preseleccionada en el producto equivalga a la del la red de distribución. Si es necesario cambiar la preselección de la tensión también se deberán en caso dabo cambiar los fusibles correspondientes del producto.

9. Productos de la clase de seguridad I con alimentación móvil y enchufe individual de producto solamente deberán ser conectados para el funcionamiento a tomas de corriente de contacto de seguridad y con conductor protector conectado.

10. Queda prohibida toda clase de interrupción intencionada del conductor protector, tanto en la toma de corriente como en el mismo producto. Puede tener como consecuencia el peligro de golpe de corriente por el producto. Si se utilizaran cables o enchufes de extensión se deberá poner al seguro que es controlado su estado técnico de seguridad.

11. Si el producto no está equipado con un interruptor para desconectarlo de la red, se deberá considerar el enchufe del cable de distribución como interruptor. En estos casos deberá asegurar de que el enchufe sea de fácil acceso y nabojo (según la medida del cable de distribución, aproximadamente 2 m). Los interruptores de función o electrónicos no son aptos para el corte de la red eléctrica. Si los productos sin interruptor están integrados en bastidores o instalaciones, se deberá instalar el interruptor al nivel de la instalación.
Informaciones elementales de seguridad

12. No utilice nunca el producto si está dañado el cable eléctrico. Compruebe regularmente el correcto estado de los cables de conexión a red. Asegure a través de las medidas de protección y de instalación adecuadas de que el cable de eléctrico no pueda ser dañado o de que nadie pueda ser dañado por él, por ejemplo al tropezar o por un golpe de corriente.

13. Solamente está permitido el funcionamiento en redes de distribución TN/TT aseguradas con fusibles de como máximo 16 A (utilización de fusibles de mayor amperaje sólo previa consulta con el grupo de empresas Rohde & Schwarz).

14. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por completo y fuertemente en la toma de corriente. Si no tiene en consideración estas indicaciones se arriesga a que se originen chispas, fuego y/o heridas.

15. No sobrecargue las tomas de corriente, los cables de extensión o los enchufes de extensión ya que esto pudiera causar fuego o golpes de corriente.

16. En las mediciones en circuitos de corriente con una tensión de entrada de $U_{\text{eff}} > 30$ V se deberá tomar las precauciones debidas para impedir cualquier peligro (por ejemplo medios de medición adecuados, seguros, limitación de tensión, corte protector, aislamiento etc.).

17. En caso de conexión con aparatos de la técnica informática se deberá tener en cuenta que estos cumplan los requisitos del estándar IEC950/EN60950.

18. A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y puede causar heridas, fuego o daños en el producto.

19. Si un producto es instalado fijamente en un lugar, se deberá primero conectar el conductor protector fijo con el conductor protector del aparato antes de hacer cualquier otra conexión. La instalación y la conexión deberán ser efectuadas por un electricista especializado.

20. En caso de que los productos que son instalados fijamente en un lugar sean sin protector implementado, autointerruptor o similares objetos de protección, el circuito de suministro de corriente deberá estar protegido de manera que usuarios y productos estén suficientemente protegidos.

21. Por favor, no introduzca ningún objeto que no esté destinado a ello en los orificios de la caja del aparato. No vierta nunca ninguna clase de líquidos sobre o en la caja. Esto puede producir cortocircuitos en el producto y/o puede causar golpes de corriente, fuego o heridas.

22. Asegúrese con la protección adecuada de que no pueda originarse en el producto una sobrecarga por ejemplo a causa de una tormenta. Si no se verá el personal que lo utilice expuesto al peligro de un golpe de corriente.

23. Los productos R&S no están protegidos contra líquidos si no es que exista otra indicación, ver también punto 1. Si no se tiene en cuenta esto se arriesga el peligro de golpe de corriente para el usuario o de daños en el producto lo cual también puede llevar al peligro de personas.

24. No utilice el producto bajo condiciones en las que pueda producirse y se hayan producido líquidos de condensación en o dentro del producto como por ejemplo cuando se desplaza el producto de un lugar frío a un lugar caliente.

25. Por favor no cierre ninguna ranura u orificio del producto, ya que estas son necesarias para la ventilación e impiden que el producto se caliente demasiado. No pongan el producto encima de materiales blandos como por ejemplo sofás o alfombras o dentro de una caja cerrada, si esta no está suficientemente ventilada.

26. No ponga el producto sobre aparatos que produzcan calor, como por ejemplo radiadores o calentadores. La temperatura ambiental no debe superar la temperatura máxima especificada en la hoja de datos.
Informaciones elementales de seguridad

27. Baterías y acumuladores no deben de ser expuestos a temperaturas altas o al fuego. Guardar baterías y acumuladores fuera del alcance de los niños. No cortocircuitar baterías ni acumuladores. Si las baterías o los acumuladores no son cambiados con la debida atención existirá peligro de explosión (atención células de litio). Cambiar las baterías o los acumuladores solamente por los del tipo R&S correspondiente (ver lista de piezas de recambio). Las baterías y acumuladores deben reutilizarse y no deben acceder a los vertederos. Las baterías y acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales. Respete en esta relación las normas nacionales de evacuación y reciclaje.

28. Por favor tengan en cuenta que en caso de un incendio pueden desprenderse del producto agentes venenosos (gases, líquidos etc.) que pueden generar daños a la salud.

29. El producto puede poseer un peso elevado. Muévalo con cuidado para evitar lesiones en la espalda u otras partes corporales.

30. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que por sus características de peso o de estabilidad no sean aptas para él. Siga siempre las instrucciones de instalación del fabricante cuando instale y asegure el producto en objetos o estructuras (por ejemplo paredes y estantes).

31. Las asas instaladas en los productos sirven solamente de ayuda para el manejo que solamente está previsto para personas. Por eso no está permitido utilizar las asas para la sujeción en o sobre medios de transporte como por ejemplo grúas, carretillas elevadoras de horquilla, carros etc. El usuario es responsable de que los productos sean sujetados de forma segura a los medios de transporte y de que las prescripciones de seguridad del fabricante de los medios de transporte sean observadas. En caso de que no se tengan en cuenta pueden causarse daños en personas y objetos.

32. Si llega a utilizar el producto dentro de un vehículo, queda en la responsabilidad absoluta del conductor que conducir el vehículo de manera segura. Asegure el producto dentro del vehículo debidamente para evitar en caso de un accidente las lesiones u otra clase de daños. No utilice nunca el producto dentro de un vehículo en movimiento si esto pudiera distraer al conductor. Siempre queda en la responsabilidad absoluta del conductor la seguridad del vehículo. El fabricante no asumirá ninguna clase de responsabilidad por accidentes o colisiones.

33. Dado el caso de que esté integrado un producto de láser en un producto R&S (por ejemplo CD/DVD-ROM) no utilice otras instalaciones o funciones que las descritas en la documentación de producto. De otra manera pondrá en peligro su salud, ya que el rayo láser puede dañar irreversiblemente sus ojos. Nunca trate de descomponer estos productos. Nunca mire dentro del rayo láser.

34. Antes de proceder a la limpieza, desconecte el producto de la red. Realice la limpieza con un paño suave, que no se deshilache. No utilice de ninguna manera agentes limpiadores químicos como, por ejemplo, alcohol, acetona o nitrodiluyente.
Sehr geehrter Kunde,


Das Rohde & Schwarz Managementsystem ist zertifiziert nach:

- DIN EN ISO 9001:2000
- DIN EN 9100:2003
- DIN EN ISO 14001:2004

DQS REG. NO 001954 QM UM

Dear Customer,

you have decided to buy a Rohde & Schwarz product. You are thus assured of receiving a product that is manufactured using the most modern methods available. This product was developed, manufactured and tested in compliance with our quality management system standards.

The Rohde & Schwarz quality management system is certified according to:

- DIN EN ISO 9001:2000
- DIN EN 9100:2003
- DIN EN ISO 14001:2004

CERTIFICAT DE QUALITÉ

Cher Client,

vous avez choisi d'acheter un produit Rohde & Schwarz. Vous disposez donc d'un produit fabriqué d'après les méthodes les plus avancées. Le développement, la fabrication et les tests respectent nos normes de gestion qualité.

Le système de gestion qualité de Rohde & Schwarz a été homologué conformément aux normes:

- DIN EN ISO 9001:2000
- DIN EN 9100:2003
- DIN EN ISO 14001:2004
Customer Support

Technical support – where and when you need it
For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support Centers. A team of highly qualified engineers provides telephone support and will work with you to find a solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz equipment.

Up-to-date information and upgrades
To keep your instrument up-to-date and to be informed about new application notes related to your instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

USA & Canada
Monday to Friday (except US public holidays)
8:00 AM – 8:00 PM Eastern Standard Time (EST)
Tel. from USA 888-test-rsa (888-837-8772) (opt 2)
From outside USA +1 410 910 7800 (opt 2)
Fax +1 410 910 7801
E-mail CustomerSupport@rohde-schwarz.com

East Asia
Monday to Friday (except Singaporean public holidays)
8:30 AM – 6:00 PM Singapore Time (SGT)
Tel. +65 6 513 0488
Fax +65 6 846 1090
E-mail CustomerSupport@rohde-schwarz.com

Rest of the World
Monday to Friday (except German public holidays)
08:00 – 17:00 Central European Time (CET)
Tel. from Europe +49 (0) 180 512 42 42*
From outside Europe +49 89 4129 13776
Fax +49 (0) 89 41 29 637 78
E-mail CustomerSupport@rohde-schwarz.com

* 0.14 €/Min within the German fixed-line telephone network, varying prices for the mobile telephone network and in different countries.
Address List

Headquarters, Plants and Subsidiaries

Headquarters
ROHDE & SCHWARZ GmbH & Co. KG
Mühldörferstraße 15 · D-81671 München
P.O. Box 80 14 69 · D-81614 München

Plants
ROHDE & SCHWARZ Messgerätebau GmbH
Riedbachstraße 58 · D-87700 Memmingen
P.O. Box 16 52 · D-87686 Memmingen

ROHDE & SCHWARZ GmbH & Co. KG
Werk Teisnach
Kalkenberg Straße 27 · D-94244 Teisnach
P.O. Box 11 49 · D-94240 Teisnach

ROHDE & SCHWARZ závod
Vítkovickeho 49
CZ-38501 Vítkovice

ROHDE & SCHWARZ GmbH & Co. KG
Dienstleistungszentrum Köln
Graf-Zeppelin-Straße 18 · D-51147 Köln
P.O. Box 98 02 60 · D-51130 Köln

Subsidiaries
R&S BICK Mobilfunk GmbH
Fritz-Hahne-Str. 7 · D-31848 Bad Münster
P.O. Box 20 02 · D-31844 Bad Münster

ROHDE & SCHWARZ FTK GmbH
Wendenschloßstraße 168, Haus 28
D-12557 Berlin

ROHDE & SCHWARZ SIT GmbH
Am Studio 3
D-12489 Berlin

R&S Systems GmbH
Graf-Zeppelin-Straße 18
D-51147 Köln

GEDIS GmbH
Sophienblatt 100
D-24114 Kiel

HAMEG Instruments GmbH
Industriestraße 6
D-63533 Mainhaußen

Locations Worldwide

Please refer to our homepage: www.rohde-schwarz.com

◆ Sales Locations
◆ Service Locations
◆ National Websites
Contents

Introduction .................................................................................................................. 3

Installation .................................................................................................................. 4
  Hardware Requirements .......................................................................................... 4
  Software Requirements and Installation ................................................................. 4

Required Instruments ............................................................................................. 5

Quick Start ............................................................................................................. 6

Frequency Responses and their Correction .............................................................. 7
  Baseband Signal Generator and RF I/Q Frequency Responses ................................ 7
  External Devices .................................................................................................... 8
  Error in the RF Frequency Response Measurements ............................................. 9

User Interface ......................................................................................................... 10
  R&S SMx RF and BB Correction Toolkit ............................................................... 10
    Window Header .................................................................................................. 11
    Menu ................................................................................................................... 11
    Toolbar ............................................................................................................... 12
    Status Line ........................................................................................................... 12
    Configuration Tab ............................................................................................... 13
    SMx Service Correction Tab ............................................................................. 16
    AMU Service Correction Tab ............................................................................ 18
    AFQ Service Correction Tab ............................................................................ 20
    SMx-K63 Correction Tab .................................................................................... 22
  Log Window .......................................................................................................... 26
    Messages Tab ...................................................................................................... 27
    Errors Tab ......................................................................................................... 27
    Instruments Tab .................................................................................................. 28
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences</td>
<td>29</td>
</tr>
<tr>
<td>General Tab</td>
<td>30</td>
</tr>
<tr>
<td>Paths Tab</td>
<td>31</td>
</tr>
<tr>
<td>Corrections Tab</td>
<td>32</td>
</tr>
<tr>
<td>Instruments Tab</td>
<td>33</td>
</tr>
<tr>
<td>Instrument Connections</td>
<td>34</td>
</tr>
<tr>
<td>Settings</td>
<td>35</td>
</tr>
<tr>
<td>Functions</td>
<td>36</td>
</tr>
<tr>
<td>Info</td>
<td>39</td>
</tr>
<tr>
<td>SMx Path</td>
<td>40</td>
</tr>
<tr>
<td>PC / SMx File Browser</td>
<td>42</td>
</tr>
<tr>
<td>R&amp;S SMx Service Corrections</td>
<td>44</td>
</tr>
<tr>
<td>R&amp;S AMU Service Corrections</td>
<td>51</td>
</tr>
<tr>
<td>R&amp;S AFQ Service Corrections</td>
<td>56</td>
</tr>
<tr>
<td>R&amp;S SMx-K63 Corrections</td>
<td>60</td>
</tr>
<tr>
<td>Log File</td>
<td>65</td>
</tr>
<tr>
<td>Index</td>
<td>71</td>
</tr>
</tbody>
</table>
Introduction

Inherently, a vector signal generator has a frequency response for the I/Q-modulated signal at RF and at the I/Q outputs. Plus, there is a lack of symmetry between the I path and the Q path, referred to as I/Q imbalance. These effects cause a deterioration in the quality of modulation (EVM) and the spectral properties of multi carrier signals, for instance. Generally speaking, these effects increase with increasing bandwidth.

These errors can be determined using the R&S SMx RF and BB Correction Toolkit program and through correction of the internal frequency response by the R&S Service. Relevant correction data can be loaded into the EEPROMs of the instruments, leading to significant improvement in the signal quality of the RF with internal modulation and at the I/Q outputs. These service corrections are available for the R&S SMU200A, R&S SMJ100A, R&S SMATE200A vector signal generators, as well as for the R&S AMU200A baseband signal generator and fading simulator and for the I/Q modulation generators R&S AFQ100A and R&S AFQ100B.

The user-defined R&S SMx-K63 frequency response correction with the R&S SMx RF and BB Correction Toolkit program also allows correction of external components such as amplifiers or filters. Other features, such as varying correction precision and selectable frequency and level ranges, are also possible. The data is stored in the SMx's file system, and can be selected and activated from the instrument. In order to use the SMx-K63 with this software, an appropriate option is needed on the R&S SMx that is to be corrected.

The following figures illustrate the spectrum of a multi carrier CW signal with and without correction.

Features:
- R&S SMx-K63 user-defined frequency response correction for the R&S SMU200A
- Service frequency response correction for the R&S SMx, R&S AMU200A and R&S AFQ100A/B
- Intuitive user interface
- Automatic execution of the correction process with record
- Supports a large number of vector signal analyzers (R&S FSL, R&S FSP, R&S FSU and R&S FSQ) and power meters (R&S NRVD, R&S NRP, R&S NRP-Z, as well as R&S SMx with R&S NRP-Z) for the measurements
- Remote control of the instruments via GPIB, USB or LAN is possible (depending on the instrument and the available options)
Installation

The R&S SMx RF and BB Correction Toolkit program is designed to be installed on a PC running the Microsoft Windows® XP or Microsoft Windows® VISTA operating system. A list of the requirements for installation follows.

Hardware Requirements

- Pentium® III, Pentium® 4 running at 1 GHz or more
- Minimum 512 MB RAM
- Minimum 250 MB free hard disk space
- LAN 100/1000 MBit interface for remote control of the instruments
- Optional National Instruments GPIB PC plug-in card or USB-GPIB adapter for remote control of the instruments
- Optional USB type A interface for remote control of the instruments

Software Requirements and Installation

- Microsoft Windows® XP or Microsoft Windows® VISTA
- Optional National Instruments VISA library, version 3.4 or later; Agilent VISA library version M 01.01 or later (for remote control of the instruments via USB or LAN)

The software package consists of the following components:
- MATLAB® Component Runtime (MCR), version 7.8 (R2008A)
- R&S SMx RF and BB Correction Toolkit
- Optional R&S NRP toolkit and R&S NRP-Z driver for VXIplug&play (for R&S NRP-Z power sensor at the PC’s USB port). See Rohde & Schwarz website, and search for ‘NRPZ driver’.

The file ‘Readme.pdf’ contains up-to-date notes on the individual components and on installation.

The following directory structure will be found after the installation:

```
…\Rohde&Schwarz\SMx RF and BB Correction Toolkit
   \smx_rf_and_bb_correction_mcr (extracted MATLAB® CTF archive)
   \icons (program icons)
   \Resources (program HTML files)
   \Setup (program setup files)
   \Log (log data)
   \Tmp (temporary data)
   \SMx K63 (SMx-K63 data)
   \Manual (user manual)
   \Help (online help files)
```

Some of the directories will only be created after the program’s first start.
Required Instruments

In order to perform the corrections, the following analysing instruments are required in addition to the instrument that is to be corrected.

<table>
<thead>
<tr>
<th>Correction</th>
<th>Analyzing Instruments</th>
</tr>
</thead>
<tbody>
<tr>
<td>R&amp;S SMx-K63</td>
<td>Vector signal analyzer, attenuator, RF cable or power meter</td>
</tr>
<tr>
<td>R&amp;S SMx service</td>
<td>Vector signal analyzer, power meter, attenuator, RF cable</td>
</tr>
<tr>
<td>R&amp;S AMU service</td>
<td>Vector signal generator, vector signal analyzer, power meter, attenuator, RF cable</td>
</tr>
<tr>
<td>R&amp;S AFQ service</td>
<td>Vector signal generator, vector signal analyzer, power meter, attenuator, RF cable</td>
</tr>
</tbody>
</table>

The following instruments can be used for this purpose.

**Vector signal analyzer:**
- R&S FSL6, R&S FSL18
- R&S FSP7, R&S FSP13, R&S FSP30
- R&S FSU8, R&S FSU26, R&S FSU43
- R&S FSQ8, R&S FSQ26, R&S FSQ40 with or without the R&S FSQ-B72 option (Var. 12)

**Power meter:**

Service:
- R&S NRVD with R&S NRV-Z51 sensor
- R&S NRP with R&S NRP-Z51 sensor
- R&S NRP-Z51 sensor (R&S NRPZ)
- R&S SMx with R&S NRP-Z51 sensor connected

R&S SMx-K63:
- R&S NRP with R&S NRP-Z11 / 21 / 91 / 22 / 23 /24 sensor
- R&S NRP-Z11 / 21 / 91 / 22 / 23 /24 sensor (R&S NRP-Z)
- R&S SMx with R&S NRP-Z11 / 21 / 91 / 22 / 23 /24 sensor connected

**Vector signal generator:**
- R&S SMJ100A
- R&S SMU200A
- R&S SMATE200A

**Attenuator:**
- 3 + 3 dB, 6 dB, 6 + 3 dB, 6 + 6 dB,
  R&S DNF series, or instrument of equivalent or better quality

**RF cable:**
- R&S Sucoflex or cable of equivalent or better quality
Quick Start

After installing the **R&S SMx RF and BB Correction Toolkit** software, the program runs using a default setting:

- The 'default.brc' setup file is loaded.
- The .\Tmp and .\Log sub directories are created for temporary files and for log files.

The following list summarizes the steps necessary to carry out a correction for the first time.

1. Configure the general settings (**Menu Options -> Preferences**).
2. It is worth saving these settings after this first step (**Menu File -> Save setup ...**). A name such as 'my_default' is recommended. This file can then be used as the basis for further configurations, and it is not usually necessary to reconfigure these general settings.
3. Configure the correction function (**Config -> Setup -> Correction function tab**) and the source of the external reference for the instruments (**Config -> Setup -> Reference source tab**).
4. Configure the power meter (**Config -> Powermeter Options -> Type tab**) and select the 2 sensors that are to be used (**Config -> Powermeter Options -> NRVD/NRP Sensor A+B tab**).
5. Choose whether the FSQ-B72 option is to be used (**Config -> Vector Signal Analyzer options -> FSQ-B72 tab**).
6. Configure the connections to remote instruments. Do this by first selecting the instrument (**Config -> Instruments Remote -> Instrument tab**), then press the **Change** button. A dialog for configuring the remote connection opens.
7. Save the settings (**Menu File -> Save setup ...**).
8. Press the **Init >>** button.
   The instruments are initialized, and the necessary information is read and displayed. After successful initialization, the label on the button changes from **Init >>** to **Local >>**.
9. Select the tab for the chosen correction, press the **All BB and RF** button and follow the instructions.
10. Press the **Local >>** button or close the program. After service corrections, the instrument must be restarted in order to activate the correction data.
Frequency Responses and their Correction

Baseband Signal Generator and RF I/Q Frequency Responses

The following block diagram shows the relevant components of the R&S SMx vector signal generator in simplified form:
The R&S AMU200A baseband signal generator and fading simulator and R&S AFQ100A / B I/Q modulation generator do without I/Q modulator and RF section. The digital I/Q signal from the modulation coder is converted to analog signals using D/A converters. Lowpass filters then remove the image spectra that arise, and the analog I/Q signal is output through amplifiers. The complex baseband signal is mixed to the RF using the I/Q modulator, and after further filtering, amplification and adjustable attenuation, the RF signal is output. The following table illustrates the frequency responses that occur, and their effect on the modulated signal:

<table>
<thead>
<tr>
<th>Frequency response</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imbalance (lack of symmetry between the I and Q frequency responses up to the summation point in the I/Q modulator or I/Q output)</td>
<td>– Poor suppression of unwanted sidebands on multi carrier signals</td>
</tr>
<tr>
<td></td>
<td>– Poor EVM in wideband modulation signals such as WLAN and WiMAX</td>
</tr>
<tr>
<td>RF I/Q frequency response, baseband I frequency response</td>
<td>– Frequency response to multi carrier signals</td>
</tr>
<tr>
<td>Comment:</td>
<td>– Poor EVM in wideband modulation signals such as WLAN and WiMAX</td>
</tr>
<tr>
<td>The baseband Q frequency response is taken into account in the imbalance as the difference between the I and Q frequency responses</td>
<td></td>
</tr>
</tbody>
</table>

The correction filter located before the D/A converters can compensate for these frequency responses. The program measures these frequency responses, and writes the data into the R&S SMx, R&S AMU or R&S AFQ, which then automatically calculates the appropriate correction filter settings in accordance with the instrument settings (e.g. RF frequency and level).

**External Devices**

The R&S SMx-K63 can also be used to correct the RF I/Q frequency response of external devices such as amplifiers, mixers and filters. This is done using the same procedure as for signal generator correction.
**Error in the RF Frequency Response Measurements**

As a result of imperfect matching between the generator (R&S SMx) and the spectrum analyzer (R&S FSx) or power meter (only R&S SMx-K63), the measured power exhibits frequency-dependent ripple and group delay distortion. This is not, however, described further, as it is correlated to the amplitude ripple. The amplitude of this ripple is defined by the product of the source and load mismatch, while the frequency of the oscillation depends on the length of the cable.

Depending on the model and the frequency range, the VSWR of the R&S SMx or of the R&S FSx is $\leq 1.8$ and for the R&S NRP-Z11/21/91 is $\leq 1.18$. This corresponds to a return loss of 11 dB or 21 dB.

The following diagram illustrates this measurement uncertainty as a function of the sum of the source and load return losses.

![Diagram](image.png)

The ‘worst case’ uncertainty can be improved if attenuators are inserted at the output of the generator and at the input of the spectrum analyzer. It is better to use two attenuators rather than one attenuator with twice the attenuation, since otherwise the effect of the cable matching and of the reflection inherent to attenuators can become the determining factors. The diagram illustrates the possible combinations of attenuators in the program.

Equivalent considerations apply to the use of the generator and of the spectrum analyzer in the relevant applications.

---

Simple coaxial cable with BNC connectors and the corresponding attenuators are not suitable for this application. Only use the recommended types or components that are of equivalent or better quality.
User Interface

The program starts up displaying the main **SMx RF and BB Correction Toolkit** screen in the Configuration program status. All the program's functions can be reached from here. Parameters can be modified, setups can be loaded or saved, and the remote connections to the instruments can be configured. Following successful initialization (Configuration tab -> **Init >>** the program changes its status to **Initialized**. It is now only possible to change parameters for the selected correction, to start correction or to change back to the Configuration program status (Configuration tab -> **Local >>**). Once correction has been started, the program's status changes to **Correction**. The appropriate corrections are made, and the data is transferred to the R&S SMx. The program's status changes back once more to **Initialized** after completion or cancellation.

A tool tip is available for every parameter, and context-sensitive help is available by pressing the F1 key.

R&S SMx RF and BB Correction Toolkit

This section describes the dialog structure. The dialogs are in Windows format. They differ in details depending on their function but they consist of the same main elements.

The following illustration shows the main screen and the components it contains.
Window Header

The header line contains the name of the dialog (SMx RF and Baseband Correction Toolkit) and the buttons for minimizing and closing the window. The buttons can be operated with the mouse.

Menu

File

Open Setup ... starts a dialog for loading a setup (*.brc). This menu item is only active when the program status is Configuration.

Save setup saves the current setup (*.brc). This menu item is only active when the program status is Configuration.

Save Setup As ... starts a dialog for saving a setup (*.brc). This menu item is only active when the program status is Configuration.

Exit closes the program. This menu item is not active when the program status is Correction, in which case the correction that is in progress must first be cancelled.

Options

Preferences ... starts a dialog for configuring general settings..

Paths ... starts a dialog for configuring program paths.

Connections Diagram ... displays a dialog with the corresponding instrument wiring, depending on which correction has been selected.

Log Window activates the log window.

Help

Program Help starts the program help.

About opens the program and version information.
**User Interface**

**R&S SMx RF and BB Correction Toolkit**

**Toolbar**

Most of the toolbar’s functions are also contained in the menu. See the corresponding explanations.

![Toolbar diagram]

- **Load setup…**
- **Preferences…**
- **Connections diagram…**
- **Toggle FSx display**
- **Save Setup**
- **Paths…**
- **Log Window**
- **Program Help**

---

**Toggle FSx Display…**

This function is **not active** when the program status is **Configuration**. It can be used, after the instruments have successfully been initialized, to activate or deactivate the R&S FSx display. The icon changes accordingly. This function does not affect the instruments display parameter (**Preferences -> Instruments**). It can be used at any time during correction to track the measurements at the R&S FSx for debug purposes.

---

**Status Line**

![Status line diagram]

- **Program state:**
  - Configuration
  - Initialized
  - Correction

- **Last message line**

- **Total correction progress**
Configuration Tab

Correction functions, the reference frequency and the remote connections between the instruments can, along with other instrument options, be configured on the Configuration tab. The **Init >>** button can be used to initialize the instruments or to return to the Local status.

**Setup**

**Correction function**
Selection for the correction function. By default, only the R&S SMx-K63 is available. See **Preferences -> Corrections -> Service Corrections** for activating the SMx Service and AMU Service connections.

**Analyzing instrument**
Selection of the device for carrying out the correction measurements for the R&S SMx-K63. The options are the R&S FSx and power meter. This parameter is only visible when the R&S SMx-K63 correction function has been selected. The devices for the service corrections are predetermined.

**Reference source**
Selection of the source for the external reference. SMx, FSx and External are possible. A summary of the wiring of the reference is displayed in the Connections diagram.
Powermeter Options

Type
Selection of the type of power meter. NRVD, NRP, NRPZ and SMx with connected NRPZ are supported.

NRP/NRVD Dual Sensor
Activates the measurement of the I/Q output responses with 2 sensors (A+B). In this case, moving the plugged in connector from I to Q is unnecessary.

Vector Signal Analyzer Options

FSQ-B72...
Activates measurement of the phase of the RF I/Q response with the R&S FSQ-B72 option. Only model 12 of this option is supported. Without this option, default values are used for the phase.

Instruments Remote

Configure ...
Opens a dialog for configuring the remote connection. The instrument is selected from the corresponding selection box. The choice of instruments depends on the selected correction, but the configuration of an instrument is identical for all corrections. See Instrument Connections Dialog.

Init >>, Local >> button

When the status of the program is 'Configuration', this button is labeled with Init >>. When it is pressed, the instruments are initialized and all the necessary data is read, while synchronization of the instruments to the reference frequency is checked.
After successful initialization, the status of the program changes to 'Initialized', and the labeling on the button changes to Local >>. If it is clicked in this condition, the instruments are returned to 'Local' status, and the program status changes to 'Configuration'.
### Info

The information table displays important information about the system as a whole and about the instruments.

<table>
<thead>
<tr>
<th>Component</th>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System</strong></td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>Initialized</td>
</tr>
<tr>
<td>Setup</td>
<td>default</td>
</tr>
<tr>
<td>Reference Frequency</td>
<td>OK</td>
</tr>
<tr>
<td><strong>SMU/SMU/SMATE</strong></td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>Connected</td>
</tr>
<tr>
<td>Connection</td>
<td>GPIB/NI, 23</td>
</tr>
<tr>
<td>Type, Ser. Nr.</td>
<td>SMATE200A, 910264</td>
</tr>
<tr>
<td>SW Version</td>
<td>2.156.0-02.04.299 beta (Release)</td>
</tr>
<tr>
<td>RF Options A</td>
<td>B106 (3, 2), B31</td>
</tr>
<tr>
<td>BB Options A</td>
<td>B13 (2, 6), B10</td>
</tr>
<tr>
<td>RF Options B</td>
<td>B206 (1, 1), B36</td>
</tr>
<tr>
<td>BB Options B</td>
<td>B13 (2, 6), B10</td>
</tr>
<tr>
<td><strong>FSU/FSU/FSQ</strong></td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>Connected</td>
</tr>
<tr>
<td>Connection</td>
<td>GPIB/NI, 23</td>
</tr>
<tr>
<td>Type, Ser. Nr.</td>
<td>FSQ-25, 200366</td>
</tr>
<tr>
<td>SW Version</td>
<td>1.05</td>
</tr>
<tr>
<td>Options</td>
<td>B72 (12), B71</td>
</tr>
<tr>
<td><strong>NRV/NRP</strong></td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>Connected</td>
</tr>
<tr>
<td>Connection</td>
<td>GPIB/NI-488.2, 9</td>
</tr>
<tr>
<td>Type, Ser. Nr.</td>
<td>NRP, 100021</td>
</tr>
<tr>
<td>SW Version</td>
<td>03.24</td>
</tr>
<tr>
<td>Options</td>
<td>B2, -</td>
</tr>
<tr>
<td>Sensor A</td>
<td>251</td>
</tr>
</tbody>
</table>

Internal versions:
- RFM module
- ATT module

Internal versions:
- DACB module
- Correction filter
SMx Service Correction Tab

Correction parameters can be configured on the SMx Service Correction tab, and corrections can be started.

Settings

Path
Selection of the R&S SMx paths that are to be corrected.

Auto, A and B (only on a two-channel instrument) are available. The default value is Auto (recommended), in which case the program automatically determines all the paths that are to be corrected. Under A or B it is possible to specify the path manually. This parameter is always set to Auto after initialization - other values are not stored in the setup.

Test Mode
When active, corrections are only carried out in test mode. They can be carried out in any desired sequence; exceeding limit values are not checked, and, because of the correlation of the individual corrections, the results may be faulty. The data is therefore not written into the EEPROM. The option is useful for finding or correcting faults in an instrument, as it allows each correction to be tested quickly.

Correction continue on error
When active, correction continues even if a limit value has been exceeded. The parameter should only be used for debug purposes. If the measured value is significantly outside the tolerance range, it makes no sense to activate this parameter, as it is necessary to correct the fault in the instrument.
Always enhanced output corrections
When active, the enhanced correction of the I/Q outputs with phase imbalance is always carried out. By default, only the amplitude imbalance is measured, and the phase imbalance is adopted from the RF. This measurement, however, requires significantly more processing, but does result in improved sideband suppression of the modulated signal. If it is not possible to measure the phase imbalance on the RF (i.e. the path only has a B13 option, no RF option) this enhanced correction is carried out automatically.

Corrections
By default, only the 'All BB and RF' correction is active after initialization has been completed. In this case, the possible individual corrections are automatically carried out in the necessary sequence, and the data is written into the instruments' EEPROMs. This procedure is necessary, as the individual corrections depend on one another, and only the correct sequence will lead to the correct results. For this reason, the corrections must be carried out from the beginning again following an interruption or a fault.
In 'Test mode' the individual corrections are active and can be executed in any sequence. No check is made for exceeding limit values, and, because of the interdependency of the individual corrections, the results may be faulty. The data is therefore not written into the EEPROM. This option is useful for finding or correcting faults in an instrument, as it allows each separate correction to be tested quickly.

**ALL BB and RF**
All possible corrections are carried out automatically.

**RF-Imb. and Outp. Resp./Imb.**
Correction of the I/Q imbalance on the RF at 1 GHz, along with the amplitude response of the I/Q outputs. See also 'Always enhanced output corrections'.

**RF-Imb. vs. RF**
Additional correction of the I/Q imbalance on the RF as a function of the RF.

**RF-Response**
Correction on the RF I/Q frequency response.

**Info**
The information table displays the possible corrections, and the associated data transfer into the instrument EEPROM's along with the relevant state. The following status messages are used here:

- **Running...** Correction/data transfer is being carried out.
- **Done** Correction/data transfer was carried out without error.
- **Done, Error** Correction was carried out, but there was an error (limit value exceeded).
- **Cancel** Correction/data transfer has been cancelled.
- **Error** Correction/data transfer has been cancelled as a result of an error.
AMU Service Correction Tab

Correction parameters can be configured on the AMU Service Correction tab, and corrections can be started.

Settings

Path
Selection of the R&S AMU paths that are to be corrected. **Auto, A** and **B** (only on a two-channel instrument) are available. The default value is Auto (recommended), in which case the program automatically determines all the paths that are to be corrected. Under A or B it is possible to specify the path manually. This parameter is always set to Auto after any initialization – other values are not stored in the setup.

Test mode
When active, corrections are only carried out in test mode. Exceeding limit values are not checked, and the data is not written into the EEPROM. The option is useful for finding or correcting faults in an instrument, as it allows each correction to be tested quickly.

Correction continue on error
When active, correction continues even if a limit value has been exceeded. If the measured value is significantly outside the tolerance range, it makes no sense to activate this parameter, as it is necessary to correct the fault in the instrument.
Corrections

By default, only the 'All BB' correction is active after initialization has been completed. In this case, the individual corrections are automatically carried out in the necessary sequence, and the data is written into the EEPROMs. This procedure is necessary, as the individual corrections depend on one another, and only the correct sequence will lead to correct results. For this reason, the corrections must be carried out from the beginning again following an interruption or a fault. Individual corrections are activated through 'Test mode'. Exceeding limit values are not checked, and the data is therefore not written into EEPROM. This option is useful for finding or correcting faults in an instrument, as it allows tests to be carried out quickly.

**ALL BB**
All possible corrections are carried out automatically.

**Output Resp. and Imb.**
Correction of the amplitude response and of the imbalance in the I/Q outputs.

Info

The information table displays the possible corrections, and the associated data transfer into the instrument EEPROMs along with the relevant state. The following status messages are used here:

- **Running...** Correction/data transfer is being carried out.
- **Done** Correction/data transfer was carried out without error.
- **Done, Error** Correction was carried out, but there was an error (limit value exceeded).
- **Cancel** Correction/data transfer has been cancelled.
- **Error** Correction/data transfer has been cancelled as a result of an error.
AFQ Service Correction Tab

Correction parameters can be configured on the AFQ Service Correction tab, and corrections can be started.

Settings

Test mode
When active, corrections are only carried out in test mode. Exceeding limit values are not checked, and the data is not written into the EEPROM. The option is useful for finding or correcting faults in an instrument, as it allows each correction to be tested quickly.

Correction continue on error
When active, correction continues even if a limit value has been exceeded. If the measured value is significantly outside the tolerance range, it makes no sense to activate this parameter, as it is necessary to correct the fault in the instrument.
Corrections

By default, only the ‘All BB’ correction is active after initialization has been completed. In this case, the individual corrections are automatically carried out in the necessary sequence, and the data is written into the EEPROMs. This procedure is necessary, as the individual corrections depend on one another, and only the correct sequence will lead to correct results. For this reason, the corrections must be carried out from the beginning again following an interruption or a fault. Individual corrections are activated through ‘Test mode’. Exceeding limit values are not checked, and the data is therefore not written into EEPROM. This option is useful for finding or correcting faults in an instrument, as it allows tests to be carried out quickly.

**ALL BB**

All possible corrections are carried out automatically.

**Output Resp. and Imb.**

Correction of the amplitude response and of the imbalance in the I/Q outputs.

**Info**

The information table displays the possible corrections, and the associated data transfer into the instrument EEPROMs along with the relevant state. The following status messages are used here:

- **Running...** Correction/data transfer is being carried out.
- **Done** Correction/data transfer was carried out without error.
- **Done, Error** Correction was carried out, but there was an error (limit value exceeded).
- **Cancel** Correction/data transfer has been cancelled.
- **Error** Correction/data transfer has been cancelled as a result of an error.
SMx-K63 Correction Tab

Correction parameters can be configured on the SMx-K63 Correction tab, and corrections can be started.

Settings

Path
Selection of the SMx path requiring correction. **A** and **B** are available (only with a two-channel device); the default value is **A**.

Correction
Selection of the correction function.

The following parameters are available, depending on the selected analysing instrument.

<table>
<thead>
<tr>
<th>R&amp;S FSx</th>
<th>Power meter</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF Response</td>
<td>RF Response</td>
</tr>
<tr>
<td>RF Image</td>
<td></td>
</tr>
<tr>
<td>RF Resp. + Img.</td>
<td></td>
</tr>
</tbody>
</table>

By default, only the amplitude is measured during the RF response correction; the phase values are taken from the existing service correction figures. If an R&S FSQ is used with the R&S FSQ-B72 option and the corresponding option (**Configuration tab -> FSQ B72**) is enabled, the phase is also measured and appropriately corrected.
Accuracy
Selection of the precision of the correction. Low, Normal and High are available; the default value is Normal. This parameter affects the number of frequency and level sampling points used, as well as the internal parameters of the simulation model used by the R&S SMx. The measuring time required increases with the level of precision. The following table illustrates the number of frequency sampling points in the baseband signal bandwidth. The level sampling values are shown on the correction graph. For the baseband signal bandwidth, see External devices -> Bandwidth.

<table>
<thead>
<tr>
<th>Accuracy</th>
<th>Sampling points in the baseband signal bandwidth</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>4</td>
</tr>
<tr>
<td>Normal</td>
<td>approx. 8</td>
</tr>
<tr>
<td>High</td>
<td>approx. 16</td>
</tr>
</tbody>
</table>

RF Range
The available parameters change according to the setting of the External Devices -> Bandwidth selection box. Start and stop frequencies can be entered if this value is set to full range and External Devices is enabled. If a bandwidth between 5 MHz and 80 MHz is selected and External Devices is enabled, it is only possible to edit the center frequency. The frequency span is determined automatically by the program and is only displayed. If External Devices is not enabled, the start and stop frequency must always be entered.

Start
Input the start frequency for the correction. The minimum value is 100 MHz, and the maximum value is determined by the RF option of the R&S SMx. Any value outside this range that is entered will not be accepted and will be replaced by the last valid input. The standard spinner step size is 10 MHz. It can be changed using the context menu to between 1 MHz and 100 MHz. The resolution of the direct input is 0.1 MHz.

Stop
Input the start frequency for the correction. See Start. The minimum span (from stop to start) is 1 MHz.

Center
Input the center frequency for the correction. See Start.

Span
Displays the span chosen by the program.
Level Range

Start
Input the start level for the correction.
The minimum value is -120 dBm, while the maximum value is 13 dBm (or 19 dBm with the high-power option). Any value outside this range that is entered will not be accepted and will be replaced by the last valid input. The standard spinner step size is 1 dBm. It can be changed using the context menu to between 1 dBm and 100 dBm. The resolution of the direct input is 0.1 dBm.

Stop
Input the stop level for the correction.
See Start. The minimum span (from stop to start) is 1 dBm.

Files

The correction files that are generated are stored in the PC in the folder specified in "SMx-K63 data", as well as in the SMX under the folder specified in "SMX SMX-K63 data". See Preferences -> Paths tab.

Automatic names

If this option is enabled, a name will be generated automatically for the correction file according to the following scheme; otherwise the name must be entered manually. The file name extension is automatically set to .frc.

1. Type: [SMU200A | SMATE200A]
2. Serial number: [xxxxxx]
3. Date: ['_yyyyMMddTHHmmss']; for example: _20071217T180025
4. Path: [_A | _B]
5. Correction: [ _Resp | _Img | _RespImg]
6. Accuracy: [ _Low | _Norm | _High]
7. RF range: [ _Start-StopMHz | StartMHz ]
8. Level range: [ _Start-StopdBm]; negative levels are identified by a preceding m.
9. External devices: [ _Ext]

Comment

Additional comments on the correction file.

Download file

If this option is selected, the correction file is automatically downloaded to the R&S SMx after the correction has been performed and placed in the folder defined in "SMX SMX-K63 data".

and activate

This option is only active if the "Download file" option is enabled. After the correction file is downloaded to the R&S SMx, the correction is selected and activated.
External Devices

External components such as amplifiers, filters and mixers can also be corrected with the aid of this function.

Activate
Activates this function.

Bandwidth
External filters with a bandwidth of less than 80 MHz can be taken into account with the aid of this parameter. If the parameter is set to "Full Range", the entire configured frequency range is corrected using a baseband signal bandwidth of 80 MHz. With a bandwidth setting between 5 MHz and 80 MHz, the bandwidth of the baseband signal is reduced to this value, and in this case it is only possible to enter the center frequency of the frequency range. In order to allow the center frequency to be adjusted slightly under this condition, an RF span of ±10% of the set bandwidth is implemented internally.

RF offset
Input a frequency offset for external mixers. The frequency range for the offset is determined by the minimum or maximum RF frequency of the R&S FSx or the power meter.

Level offset
Input a level offset for an amplifiers or other device. The program specifies a specific range for the level offset, depending on the selected additional attenuator value. The absolute minimum value is −20 dB for the R&S FSx and −10 dB for the power meter. The absolute maximum value is the same in both cases, namely +30 dB.

Additional attenuator
With external amplifiers, the maximum input level at the measuring instrument (R&S FSx or power meter) is reduced by this additional attenuator. The absolute minimum value is −0 dB and the absolute maximum value is +30 dB. If you use the power sensors R&S NRP-22 / 23 /24, the external attenuator of this sensors will be automatically used for this parameter, in this case the value can only be increased.

Ensure that the attenuator can handle the required power.
**Corrections**
The chosen corrections can be started, or the correction files can be managed.

**Corrections >>**
The selected correction is carried out.

**Manage Corrections Files ...**
The correction files in the PC and the R&S SMx can be managed, and correction files in the R&S SMx can be activated.
For details, see PC SMx FileBrowser.

**Log Window**

The program uses the 'Log Window' panel to inform the user about events that have occurred. The window is divided in the tabs **Messages**, **Errors** and **Instrument**, each of them displaying the relevant information.

Only the messages are active by default. Contents can be selected and copied to the clipboard.

**Exit**
The dialog is closed.

**Help**
Help for panel.
Messages Tab

The Messages tab displays information about the progress of the program; error messages are highlighted in red. The example illustrates the initialization of the instruments, with an error occurring at the third instrument.

Errors Tab

The Errors tab displays the MATLAB® error stack.

- The first line of the message gives a precise cause for the error.
- The second line is the identifier.
- The third is used to identify the cause of the error.

The "caller stack" is output on the following lines, making it possible to identify the point in the program where the error occurs. The following example shows the error stack associated with the initialization of an unaddressable instrument (incorrect address, or not connected).
Instruments Tab

The Instruments tab displays the static error messages (only R&S SMx, R&S AMU) as well as the error queue of the instruments being used after initialization and during the course of corrections.
Preferences

The ‘Preferences’ panel allows general settings to be configured that apply to all corrections. The parameters are arranged according to their function on the subsequent tabs.

The parameters are arranged according to their function in the tabs General, Paths, Corrections and Instruments.

OK
The changed parameters in the dialog are accepted and the dialog is closed.

Cancel
The changed parameters in the dialog are not accepted, and the dialog is closed.

Help
Help for panel.
**General Tab**

**Log Window**

On startup

'On startup' starts the Log Window automatically when the program starts (recommended).

Add error and instruments log

This parameter activates the logs for the program and instrument errors in the log window (recommended).

**Miscellaneous**

Save settings on exit

'Save settings on exit' automatically saves the settings in the current setup file when closing the program (recommended).

GUI Look and Feel

'GUI Look and Feel' makes it possible to choose the look and feel of the graphical user interface. **Windows and PlasticXP** are supported. However, it is necessary to restart the program after changing this parameter.
The paths for temporary and log files can be changed here. The default values are .\Tmp and .\Log.

The paths for the storage locations of the corresponding data can be changed here. See the following table for the default values.

<table>
<thead>
<tr>
<th>Type</th>
<th>Location</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temp data</td>
<td>PC</td>
<td>.\Tmp</td>
</tr>
<tr>
<td>Log data</td>
<td>PC</td>
<td>.\Log</td>
</tr>
<tr>
<td>Statistic data</td>
<td>PC</td>
<td>.\Statistic</td>
</tr>
<tr>
<td>SMx-K63 data</td>
<td>PC</td>
<td>.\SMx K63</td>
</tr>
<tr>
<td>SMx SMx-K63 data</td>
<td>SMx</td>
<td>D:\SMxRFandBBCorrectionToolkit\SMx K63</td>
</tr>
</tbody>
</table>

Select the relevant path from the list, then choose the **Change ...** button.

The new path can then be changed in the dialog that opens. A standard path dialog is opened for the PC paths. See **SMx Path** for the SMx paths.
Corrections Tab

General

Correction graphics
'Correction graphics' activates the graphical display of measurements during the correction (recommended).

Functions

SMx/AMU/AFQ service corrections
'SMx/AMU service corrections' activates the service corrections for this instrument. The service password must be entered to use these functions.

User name for service corrections
'User name for service corrections' is the username. It is used in the logs for service corrections. The recommended entry is: Company/Department-name.

SMx-K63 corrections
'SMx-K63 corrections' activates the user-defined corrections for the R&S SMx-K63 (not recommended for service).
Instruments Tab

Display update on

'Display update on' activates the display of the instruments used during correction. This causes the program to run significantly more slowly, and is therefore only recommended for debug purposes (see also 'Toggle FSx Display' on the toolbar).

VISA/GPIB vendor

The 'VISA/GPIB vendor' permits the selection of the GPIB/VISA library manufacturer. National Instruments and Agilent are supported.

FSx attenuator pad

'FSx attenuator pad' permits selection of the external attenuator for measurements with the R&S FSx. The values 6, 9 (6 + 3) and 12 (6 + 6) dB are possible.
Instrument Connections

Remote control of the instruments can be configured on the **Instrument connection** panel. It is also possible to test the connection, while information about the hardware and the drivers can be displayed. In addition, the selected connection can be scanned for instruments, and suitable instruments can be accepted easily by double-clicking the entry.

**OK**

The changed parameters in the dialog are accepted and the dialog is closed.

**Cancel**

The changed parameters in the dialog are not accepted, and the dialog is closed.

**Help**

Help for panel.
Settings

Interface/Driver
Selects the combination of the interface and driver. The two following parameters change, depending on the selected interface/driver.

The possible parameters depend on the instruments that are to be configured. The program always allows all basically possible parameters. Depending on the individual instrument and on the included options, not every parameter is in fact possible (e.g. the USB interface is only supported by the R&S SMATE, not by the R&S SMU or R&S SMJ).

GPIB/NI-488.2
GPIB/VISA
Board ID
Selects the board ID, with values in the range 0 to 7. The default value is 0. This makes it possible to select a particular connection when several GPIB cards or adapters have been installed.

GPIB Address
Selects the GPIB address, in the range of values 1 to 30. The default value is automatically chosen depending on the instrument (e.g. 28 for an R&S SMU).

USB/VISA
USB/VXIPnP
The VISA resource string for a USB connection is constructed as follows:
USB::Vendor ID::Instrument ID::Instrument serial number::INSTR

The program automatically generates both the serial number and the resource string on the basis of the selected instrument.
**User Interface**  

**Type**  
Selects the instrument for the USB connection. The available selection depends on the instruments to be configured (e.g., only the R&S SMATE is possible for the R&S SMx). The instrument ID is generated from this information.

**Serial**  
Enter the serial number of the R&S Instrument. Rohde & Schwarz serial numbers always consist of 6 figures.

**TCPIP/VISA**

| IP Address or Name | 192.168.123.1 |

**IP Address or Name**  
Enter the name of the R&S instrument or the IP address (see the relevant instrument manual or the online help). The instrument address can be determined by scanning the appropriate subnet (see Scan Subnet).

**Functions**

**Interface/Driver Info**  
Provides information about the interface and the driver in the Info window. This allows the installation of the driver and the versions to be checked. Some examples follow.

**GPIB/NI-488.2**

![Image of GPIB/NI-488.2 interface information]
R&S SMx RF and BB Correction Toolkit User Interface

**GPIB/VISA**

- Interface/Driver Info:
  - Adapter Name: NI
  - Adapter Driver Name: C:\Program Files\MATLAB\R2007a\toolbox\instrumer
  - Adapter Driver Version: 2.4.2
  - Installed Boards:
    - Vendor Driver Name: visa32.dll
    - Vendor Driver Description: National Instruments VISA Driver
    - Vendor Driver Version: 3.01

**USB/VISA**

- Interface/Driver Info:
  - Vendor Driver Name: visa32.dll
  - Vendor Driver Description: National Instruments VISA Driver
  - Vendor Driver Version: 3.01

**USB/VXIPnP**

- Interface/Driver Info:
  - Manufacturer: Rohde & Schwarz GmbH
  - Model: R&S NRZ2 Power Sensor
  - Driver Version: 1.0
  - Driver Driver Name: C:\Winpnp\VEND\en\nxpnp_32.dll

**TCP/IP/VISA**

- Interface/Driver Info:
  - Local Host: andreas@3DClab\192.168.121.100
  - Vendor Driver Name: visa32.dll
  - Vendor Driver Description: National Instruments VISA Driver
  - Vendor Driver Version: 3.01
Scan Subnet

'Scan Subnet' searches, depending on the interface/driver, the GPIB bus, the USB bus or the local subnet for instruments. The instruments that are found are displayed in the Info field. Suitable instruments (such as an R&S SMU in the case of R&S SMx) are displayed in green, and can be accepted by double-clicking. This makes it easier to enter the parameters, particularly for USB and LAN connections.

Scan GPIB

Scan USB

Scan Subnet
Test Connection

'Test Connection' allows the remote connection to the instrument to be tested. The relevant information is displayed in the Info field.

Info

Displays the relevant information. Contents can be selected and copied to the clipboard.
SMx Path

This dialog can be used to set the path for the R&S SMx-K63 correction data in the R&S SMx. The dialog also supports creation, renaming, moving and deletion of folders.

**OK**
The changed parameters in the dialog are accepted and the dialog is closed.

**Cancel**
The changed parameters in the dialog are not accepted, and the dialog is closed.

**Help**
Help for panel.

**Context Menu**
The context menu is opened by a right mouse click in the folder window.

- **New Folder** creates a new folder, initially called *New Folder*. The name can be edited.
- **Rename** allows the name of the folder to be edited.
- **Delete** deletes the folder after a confirmation query.
- **Cut** removes the folder and places it on the clipboard.
- **Paste** inserts the contents of the clipboard into the current folder.
- **Break** clears the contents of the clipboard.
**Toolbar**

Most of the toolbar functions are also available in the context menu. See the corresponding descriptions.

- **Select Drive** selects the disk drive. Drive C: is not available here in the R&S SMx because it is the system partition of the device and no user data should be stored in the system partition.
- **Go up one level** opens the higher-level folder.
- **Current path** displays the current folder.

---

![Diagram of toolbar functions](image)

![Diagram of drive selection and folder navigation](image)
PC / SMx File Browser

The R&S Smx-K63 correction data in the PC and the R&S Smx can be managed with this dialog. The dialog also supports renaming, copying, moving and deletion of files and folders. Correction data can be loaded into the R&S Smx and activated. Copying folders between the PC and the R&S Smx or to the R&S Smx is not supported.

Exit

The dialog is closed.

Help

Help for panel.

Context Menu

The context menu is opened by a right mouse click in the folder window.

New Folder creates a new folder, initially called New Folder. The name be edited.

Rename allows the name of the object to be edited.

Delete deletes the object after a confirmation query.

Cut removes the object and places it on the clipboard.

Copy makes a copy of the object on the clipboard.

Paste inserts the contents of the clipboard into the current folder.

Break clears the contents of the clipboard.

Load and Activate is a menu item that is only active on the R&S Smx in connection with a correction file (with extension .frc). The selected correction file is loaded and activated.
**Select Drive** selects the disk drive. Drive C: is not available here on the R&S SMx because it is the system partition of the device and no user data should be stored in the system partition.

**Go up one level** opens the higher-level folder.

**Current path** displays the current folder.
The level correction and all internal adjustments of the R&S SMx must be carried out in order to perform the correction. The following list indicates the necessary steps.

Create the remote and reference frequency connection in accordance with the following illustrations.
1. Configure the general settings (Menu Options -> Preferences).
2. Set the correction function (Config -> Setup -> Correction function tab) to SMx Service Correction, and select the source of the external reference for the instruments (Config -> Setup -> Reference source tab).
3. Configure the connections to remote instruments. Do this by first selecting the instrument (Config -> Instruments Remote -> Instrument tab), then press the Change ... button. A dialog for configuring the remote connection opens.
4. Configure the power meter (Config -> Powermeter Options ->Type tab) and select the 2 sensors that are to be used (Config -> Powermeter Options ->NRVD/NRP Sensor A+B tab).
5. Choose whether the R&S FSQ-B72 option is to be used (Config -> Vector Signal Analyzer options ->FSQ-B72 tab).
6. Save the settings (Menu File -> Save setup ...).
7. Press the Init >> button.
   The instruments are initialized, and the necessary information is read and displayed. After successful initialization, the label on the button changes from Init >> to Local >>.
8. Select the SMx Service Correction tab, press the All BB and RF button and follow the instructions.
Create the RF and I/Q connections according to the following illustration and the directions from the program.

- The corrections can be stopped at any time by pressing the **Cancel** button on the corresponding progress display. It will, however, then be necessary to start them right from the beginning.
- At the beginning of every correction, the presence of the necessary connections is tested. In the event of a fault, the user is directed to create them.
- The value of the attenuator selected is checked by measuring the level. This is necessary in order to avoid overdriving the R&S FSQ during the measurement.
- Any limit values that may be set are shown on the graphs by a black 'limit line'. If the limits are exceeded, a message is output and the correction is interrupted.
a) The RF I/Q imbalance at 1 GHz is determined first; next the amplitude response of the I/Q outputs is measured.
Under enhanced output correction, the amplitude response of the I output, and the amplitude and phase imbalances of the I/Q outputs are measured.
b) The dependency of the RF I/Q imbalance on the RF frequency is measured second.
c) The I/Q modulation frequency response on the RF is measured third.

When the correction measurements have been completed, the associated data is written into the EEPROMs of the R&S SMx.

9. Press the Local >> button or close the program.
   The instrument must be restarted in order to activate the correction data.

For the best signal quality, the high-quality correction mode must be used in the R&S SMx. The instrument description or the online help provide more details.
R&S AMU Service Corrections

All internal adjustments of the R&S AMU must be carried out in order to perform the correction. The following list indicates the necessary steps.

Create the remote and reference frequency connection in accordance with the following illustrations.
1. Configure the general settings (Menu Options -> Preferences).
2. Set the correction function (Config -> Setup -> Correction function tab) to AMU Service Correction, and select the source of the external reference for the instruments (Config -> Setup -> Reference source tab).
3. Configure the connections to remote instruments. Do this by first selecting the instrument (Config -> Instruments Remote -> Instrument tab), then press the Change ... button. A dialog for configuring the remote connection opens.
4. Configure the power meter (Config -> Powermeter Options -> Type tab) and select the 2 sensors that are to be used (Config -> Powermeter Options -> NRVD/NRP Sensor A+B tab).
5. Save the settings (Menu File -> Save setup ...).
6. Press the Init >> button.

The instruments are initialized, and the necessary information is read and displayed. After successful initialization, the label on the button changes from Init >> to Local >>.

Select the AMU Service Correction tab, press the All BB button and follow the instructions.
Create the RF and I/Q connections according to the following illustration and the directions from the program.

- The corrections can be stopped at any time by pressing the Cancel button on the corresponding progress display. It will, however, then be necessary to start them right from the beginning.
- At the beginning of every correction, the presence of the necessary connections is tested. In the event of a fault, the user is directed to create them.
- The value of the attenuator selected is checked by measuring the level. This is necessary in order to avoid overdriving the R&S FSQ during the measurement.
- Any limit values that may be set are shown on the graphs by a black 'limit line'. If the limits are exceeded, a message is output and the correction is interrupted.
- The amplitude response of the I output, and the amplitude and phase imbalances of the I/Q outputs are measured.
When the correction measurements have been completed, the associated data is written into the EEPROMs of the R&S AMU.

7. Press the **Local >>** button or close the program.
   The instrument must be restarted in order to activate the correction data.
R&S AFQ Service Corrections

All internal adjustments of the R&S AFQ must be carried out in order to perform the correction. The following list indicates the necessary steps.

Create the remote and reference frequency connection in accordance with the following illustrations.
1. Configure the general settings (Menu Options -> Preferences).
2. Set the correction function (Config -> Setup -> Correction function tab) to AFQ Service Correction, and select the source of the external reference for the instruments (Config -> Setup -> Reference source tab).
3. Configure the connections to remote instruments. Do this by first selecting the instrument (Config -> Instruments Remote -> Instrument tab), then press the Change ... button. A dialog for configuring the remote connection opens.
4. Configure the power meter (Config -> Powermeter Options -> Type tab) and select the 2 sensors that are to be used (Config -> Powermeter Options -> NRVD/NRP Sensor A+B tab).
5. Save the settings (Menu File -> Save setup ...).
6. Press the Init >> button.

The instruments are initialized, and the necessary information is read and displayed. After successful initialization, the label on the button changes from Init >> to Local >>. Select the AFQ Service Correction tab, press the All BB button and follow the instructions.
Create the RF and I/Q connections according to the following illustration and the directions from the program.

- The corrections can be stopped at any time by pressing the Cancel button on the corresponding progress display. It will, however, then be necessary to start them right from the beginning.
- At the beginning of every correction, the presence of the necessary connections is tested. In the event of a fault, the user is directed to create them.
- The value of the attenuator selected is checked by measuring the level. This is necessary in order to avoid overdriving the R&S FSQ during the measurement.
- Any limit values that may be set are shown on the graphs by a black 'limit line'. If the limits are exceeded, a message is output and the correction is interrupted.
- The amplitude response of the I output, and the amplitude and phase imbalances of the I/Q outputs are measured.
When the correction measurements have been completed, the associated data is written into the EEPROMs of the R&S AFQ.

7. Press the **Local >>** button or close the program. The instrument must be restarted in order to activate the correction data.
R&S SMx-K63 Corrections

The level correction, R&S SMx service corrections and all internal adjustments of the R&S SMx must be carried out in order to perform the R&S SMx-K63 corrections. The following list indicates the necessary steps.

Create the remote and reference frequency connection in accordance with the following illustrations.

Analyzing instrument R&S FSx
Reference source FSx

Reference source external
Analyzing instrument Power meter

1. Configure the general settings (Menu Options -> Preferences).
2. Set the correction function (Config tab -> Setup -> Correction function) to SMx-K63.
3. Select the analysing instrument (Config tab -> Setup -> Analysing instrument) and the source of the external reference for the instruments (Config tab -> Setup -> Reference source). This function is only available for the instrument FSx.
4. Configure the power meter type (Config tab -> Powermeter Options -> Type).
5. Choose whether the R&S FSQ-B72 option is to be used (Config -> Vector Signal Analyzer options -> FSQ-B72 tab).
6. Configure the connections to remote instruments. Do this by first selecting the instrument (Config tab -> Instruments Remote -> Instrument), then press the Change … button. A dialog for configuring the remote connection opens.
7. Save the settings (Menu File -> Save setup …).
8. Press the Init >> button. The instruments are initialized, and the necessary information is read and displayed. After successful initialization, the label on the button changes from Init >> to Local >>.
9. Select the SMx-K63 tab, select the path, type of correction and the accuracy.
10. Select the RF and level range, the settings for the external devices and files.
11. Press the Corrections button and follow the instructions.

The maximum output power of the R&S SMx during correction is displayed at the start of the process if External Devices is enabled. The exact value depends on how the R&S SMx has been configured and on the selected level range. It is essential to observe the following points when using external amplifiers:

- It may be necessary to adjust the input power of the amplifier by inserting an attenuator. Level offset must be corrected appropriately in this case.
- A suitable power attenuator with appropriate cabling must be connected to the amplifier output in order to protect the measuring instrument.
Create the RF and I/Q connections according to the following illustration and the directions from the program.

Analyzing instrument R&S FSx

Analyzing instrument Power meter

- The corrections can be stopped at any time by pressing the Cancel button on the corresponding progress display.
- At the beginning of every correction, the presence of the necessary connections is tested. In the event of a fault, the user is directed to create them.
- The value of the attenuator and level offset selected is checked by measuring the level. This is necessary in order to avoid overdriving the instrument during the measurement.
Press the Local >> button or close the program.
Log File

In order to support troubleshooting and to record the corrections, a log file is saved in HTML format on the PC in the .\Log subdirectory, as well as graphs of the corrections carried out. The following illustration shows the structure of the file names.

<table>
<thead>
<tr>
<th>Name</th>
<th>Änderungsdatum</th>
<th>Typ</th>
<th>Größe</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFQ008_100003.html</td>
<td>25.04.2008 17:29</td>
<td>Firefox Document</td>
<td>15 KB</td>
</tr>
<tr>
<td>AMU200A_100003.html</td>
<td>13.11.2007 13:13</td>
<td>Firefox Document</td>
<td>10 KB</td>
</tr>
<tr>
<td>AMU200A_100003_SRVC_OUT_RESP_IMB_FULL_A_20080425T100414.html</td>
<td>13.11.2007 13:13</td>
<td>Adobe Acrobat Document</td>
<td>7 KB</td>
</tr>
<tr>
<td>SMATE200A_910284.HTML</td>
<td>25.04.2008 15:34</td>
<td>Firefox Document</td>
<td>2 KB</td>
</tr>
<tr>
<td>SMATE200A_910284_Sm5_RX_RFIMG_A_20080401163741.html</td>
<td>18.04.2008 16:38</td>
<td>Adobe Acrobat Document</td>
<td>6 KB</td>
</tr>
<tr>
<td>SMATE200A_910284_Sm5_RX_RFRESP_A_20080401163741.pdf</td>
<td>18.04.2008 16:38</td>
<td>Adobe Acrobat Document</td>
<td>6 KB</td>
</tr>
<tr>
<td>SMATE200A_910284_SRVC_BE_RESP_A_RF_A_20080410T140047.pdf</td>
<td>10.04.2008 14:34</td>
<td>Adobe Acrobat Document</td>
<td>4 KB</td>
</tr>
<tr>
<td>SMATE200A_910284_SRVC_RF_RESP_A_RF_A_20080410T152559.pdf</td>
<td>10.04.2008 15:34</td>
<td>Adobe Acrobat Document</td>
<td>9 KB</td>
</tr>
</tbody>
</table>

The individual records are appended to the log file. As correction proceeds, all the outputs in the Messages, Errors and Instruments log windows are stored, appropriately formatted, in the log file. A link is also provided to the graphs.

The following instrument error messages are generated for technical reasons, and do not represent faults:

- R&S SMx -300, Instrument-specific error, output unleveled: gain control on upper limit
- R&S FSx -113, Undefined header, inp:filter:yig off (with R&S FSL)

A corresponding log file, with graphs, is also created during service corrections for the instrument to be corrected (R&S SMx, R&S AMU, R&S AFQ) in the directory:
C:\ProgramFiles\Rohde&Schwarz\SMxRFandBBCorrectionToolkit\ServiceCorrection

Some log examples follow.
1. Log structure

General

Program version, date: 01.00.10, 29.07.2007
User: R&S/1GF6-AH
Correction function: SMx Service
Test mode: Off
Continue on error: On

Instruments

SMU/SMJ/SMATE

Connection: TCP/IP/VISA, SMATE200A910234
Type, serial number: SMATE200A, 910234
SW version: 2.1.56.0-02.04.299 beta (Release)
RF options: A: B16 (3, 2), B31
BB options: A: B13 (2, 6), B10
RF options: B: B205 (1, 1), B36
BB options: B: B13 (2, 6), B10

DACIF Temperature: 35.6935 °C

Models

MERD (part number, serial number, revision): 1400.7805.02, 100163, 04.00
DACE A (part number, serial number, revision): 1141.8190.02, 100134, 02.04
RFM A (part number, serial number, revision): 1141.3101.02, 100641, 06.16
SATT A (part number, serial number, revision): 1400.3400.06, 100021, 04.03
DACE B (part number, serial number, revision): 1141.8190.02, 100091, 02.04
RFM B (part number, serial number, revision): 1141.3101.02, 100204, 06.09
SATT B (part number, serial number, revision): 1141.3501.02, 100087, 03.02

FSL/FSF/FSU/FSQ

Connection: TCP/IP/VISA, 10.112.10.4
Type, serial number: FSQ-26, 200366
SW version: 4.05
Options: B72 (12), B71
NRVD/NRP

Connection: GPIB/VISA, 9
Type, serial number: NRP, 100021
SW version: 03.24
Options: E2, -
Sensor A Z51

Correction

Function: ALL

RF I/Q-Imbalance, Path A

Started (time): 13-Aug-2007 18:07:27
Finished (state, time): Done, 13-Aug-2007 18:08:16

I/Q-Output Response and Imbalance, Path A

Started (time): 13-Aug-2007 18:08:16
Finished (state, time): Done, 13-Aug-2007 18:09:11

RF I/Q-Imbalance versus RF, Path A

Started (time): 13-Aug-2007 18:09:11

RF I/Q-Response, Path A


Instrument:
SMix error que
-330,"Device specific error,Output un leveled Gain Control on Upper Limit"
-330,"Device specific error,Output un leveled Gain Control on Upper Limit"

Finished (state, time): Done, 13-Aug-2007 18:15:54
2. Fault in the RF connection test R&S SMx -> R&S FSx

RF I/Q-Imbalance, Path B

Started (time): 10-Aug-2007 14:44:55
Finished (state, time): Error, 10-Aug-2007 14:46:13

3. Fault in the remote connection to the R&S FSx (cable was removed)

RF I/Q-Response, Path A

Started (time): 10-Aug-2007 18:05:02
R&S SMx RF and BB Correction Toolkit Log File

Graphic

Message

Instrument/Program error

Error

Message: Error using ==> interface fopen at 146 VIISA. The connection for the given session has been lost.
Identifier: instrument fopen failed
Stack (1):
File: C:\Programs\MATLAB\R2007a\toolbox\instrument\instrument\@icinterface\fopen.m
Line: 146
Stack (2):
File: D:\\Mail\\work\SMUKorrektau programa\\01.00.10\\msq_meas_mcw.m
Name: msq_meas_mcw
Line: 17
Stack (3):
File: D:\\Mail\\work\SMUKorrektau programa\\01.00.10\\snx_corr_rf_iq_res.m
Name: snx_corr_rf_iq_res/measure_and_set_rf_res
Line: 959
Stack (4):
File: D:\\Mail\\work\SMUKorrektau programa\\01.00.10\\snx_corr_rf_iq_res.m
Name: snx_corr_rf_iq_res
Line: 467
Stack (5):
File: D:\\Mail\\work\SMUKorrektau programa\\01.00.10\\snx_src_correction.m
Name: snx_src_correction
Line: 198
Stack (6):
File: D:\\Mail\\work\SMUKorrektau programa\\01.00.10\\snx_rf_and_bb_correction.m
Name: PanelSmxCorrCallback
Line: 623
Stack (7):
File: D:\\Mail\\work\SMUKorrektau programa\\01.00.10\\snx_rf_and_bb_correction.m
Name: snx_rf_and_bb_correction
Line: 232

Finished (state, time): Error , 10-Aug-2007 18:10:31
Index

A

Add error and instrument log.................30
AFQ
Remote and reference frequency connection..........................56
RF and I/Q............................................58
AFQ Corrections..................................21
ALL BB............................................21
Output Resp. and Imb...........................21
AFQ Info.............................................21
Cancel.............................................21
Done.............................................21
Done, Error.....................................21
Error.............................................21
Running.........................................21
AFQ Service Correction tab..................20
Corrections......................................21
Info................................................21
AFQ Settings
Correction continue on error ...............20
Test mode......................................20
ALL BB........................................19,21
ALL BB and RF SMx.............................16
Always enhanced output corrections SMx....16
Amplitude I.....................................48,56,60
Amplitude of imbalance vs. RF..............48
Amplitude response................................46
Amplitude response ATT........................49
Amplitude response RF..........................49
AMU
Remote and reference frequency connection..........................51
RFfund I/Q........................................54
AMU Corrections..................................19
ALL BB........................................19
Output Resp. and Imb...........................19
AMU Info............................................19
Cancel............................................19
Done..............................................19
Done, Error.....................................19
Error..............................................19
Running..........................................19
AMU Service Correction tab..................18
Corrections......................................19
Info................................................19
Settings..........................................18
AMU Settings....................................18
Correction continue on error.................19
Path...............................................18
Test mode.......................................18

B

Baseband and RF I/Q Frequency
Responses and Their Correction .............4
Button
ALL BB..............................................19,21
ALL BB and RF...................................16
Cancel............................................29,33
Change...........................................31
Help..............................................29,33
Init>>, Local >> button........................13
Interface Driver................................33
Interface Driver Info..........................35
OK................................................29,33
Output Resp. and Imb..........................19,21
RF Imb. and Outp. Resp./Imb..................16
RF Imb. vs. RF..................................16
RF Response.......................................16
Scan Subnet.....................................37
Test Connection..................................38

C

Cancel............................................16,19,21
Configuration tab................................11
Info...............................................13
Init>>, Local >> button........................13
Instruments Remote.............................13
Powermeter Options............................12
Setup.............................................12
Vector Signal Analyzer Options..............13
Configure......................................13
Connection
Remote and reference frequency connection
AFQ..................................................56
AMU..................................................51
SMx..................................................42
RF and I/Q
AFQ..................................................58
AMU..................................................54
SMx..................................................44
Correction continue on error
AFQ Settings.....................................20
AMU Settings....................................19
Correction continue on error SMx.........15
Correction function............................12
Correction graphics............................31
Corrections
AFQ.................................................21
ALL BB AFQ.......................................21
ALL BB AMU.......................................19
ALL BB and RF SMx.............................16
R&S SMx RF and BB Correction Toolkit

Instruments Remote
  Configure................................................13
Instruments tab
  Display update on ........................................32
  External attenuation .....................................32
  VISA/GPIB vendor .......................................32
Interface Driver ...............................................33
Interface Driver Info ........................................35

L
Log examples ..................................................67
  Fault in the remote connection to the
    R&S FSx ................................................70
  Fault in the RF connection test
    R&S SMx -> R&S FSx ................................70
Log structure ................................................67
Log File ........................................................66
Log Window ....................................................27
  Add error and instrument log ............................30
Errors tab .....................................................28
  Instruments tab ............................................28
Messages tab ................................................27
  On startup ................................................30

M
Miscellaneous
  GUI Look and Feel .........................................30
  Save settings on exit ....................................30
  Modulation frequency response ..........................49

N
NRP/NRVD Dual Sensor.........................................13

O
On startup ......................................................30
  Output Resp. and Imb. ....................................19,21

P
Password ........................................................32
Path
  AMU Settings .............................................18
  Paths tab ..................................................31
  SMx ........................................................15
Paths tab
  Change ......................................................31
  Path ........................................................31
  Type ........................................................31
Phase ..........................................................46
  Phase of imbalance vs. RF ..............................48
Power Meter
  R&S NRP ...................................................1
  R&S NRP-Z ................................................1
  R&S NRVD ..................................................1
Powermeter
  NRP/NRVD Dual Sensor .....................................13
  Type .........................................................12
Preferences ...................................................29
  Cancel ......................................................29
  Corrections tab ...........................................31
  Help ........................................................29
  Instruments tab ...........................................32
  OK ..........................................................29
  Paths tab ..................................................31

Q
Quick Start ...................................................4

R
R&S AFQ100A I/Q Modulation Generator ...............1
R&S AFQ100B I/Q Modulation Generator ...............1
R&S SMx RF and BB correction toolkit ..................1
R&S SMx Service Corrections ..............................42
Record corrections .........................................66
Reference source ............................................12
Remote and reference frequency connection
  AFQ ..........................................................56
  AMU ........................................................51
  SMx .........................................................42
Remote control ...............................................1
  GPIB ........................................................1
  LAN ........................................................1
  USB .........................................................1
Required Instruments .......................................3
  Attenuator ................................................3
  Power meter ...............................................3
  RF cable ...................................................3
  Vector signal generator ..................................3
RF and I/Q connection
  AFQ ........................................................58
  AMU ........................................................54
  SMx .........................................................44
RF I/Q Imbalance ...........................................46
RF Imb. and Outp. Resp./Imb. SMx ......................16
RF Imb. vs. RF SMx ........................................16
RF Response SMx ............................................16
Running .......................................................16,19,21
Index

R&S SMx RF and BB Correction Toolkit

S
Save settings on exit .................................. 30
Scan Subnet ............................................ 37
Settings
Always enhanced output corrections SMx ... 16
Correction continue on error
AFQ ..................................................... 20
AMU .................................................... 19
SMx .................................................... 15
Path
AMU .................................................... 18
SMx .................................................... 15
SMx .................................................... 15
Test mode
AFQ ..................................................... 20
AMU .................................................... 18
SMx .................................................... 15
Setup
Correction function .................................. 12
Reference source .................................... 12
Signal Generator
R&S AMU200A ........................................ 1
R&S SMATE200A ...................................... 1
R&S SMJ100A .......................................... 1
R&S SMU200A .......................................... 1
SMU-K63 corrections .................................. 32
SMx
Remote and reference frequency
connection ............................................ 42
RFund I/Q .............................................. 44
SMx Corrections ...................................... 16
ALL BB and RF ........................................ 16
RF Imb. and Outp. Resp./Imb. ...................... 16
RF Imb. vs. RF ........................................ 16
RF Response .......................................... 16
SMx Info ............................................. 16
Cancel ............................................... 16
Done ............................................... 16
Done, Error .......................................... 16
Error .............................................. 16
Running ............................................. 16
SMx Service Correction tab ....................... 14
Corrections .......................................... 16
Info .................................................. 16
Settings ............................................. 15
SMx Settings
Always enhanced output corrections ........ 16
Correction continue on error ...................... 15
Path .................................................. 15
Test mode .......................................... 15
SMx/AMU service corrections .................. 32
Software components ................................ 2
Software requirements ............................. 2

T
Tab
AFQ Service Correction ......................... 20
AMU Service Correction ....................... 18
Correction .......................................... 11
Corrections ........................................ 31
Errors ............................................. 28
Instruments ....................................... 28,32
Messages .......................................... 27
Paths ............................................... 31
SMx Service Correction tab ................... 14
Test Connection ................................... 38
Test mode
AFQ Settings ....................................... 20
AMU Settings ....................................... 18
SMx .............................................. 15
Troubleshooting .................................. 66
Type ............................................... 12

U
User Interface ...................................... 8
Menu ............................................... 10
Online Help ....................................... 10
Status Line ........................................ 11
Tool Bar ........................................... 10
Window header ................................... 9

V
Vector Signal Analyzer
R&S FSL ............................................. 1
R&S FSP ............................................. 1
R&S FSQ ............................................. 1
R&S FSU ............................................. 1
VISA/GPIB vendor ................................ 32
Agilent ........................................... 32
National Instruments ......................... 32